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PRECURSOR
The purpose of this e-book is to provide a simple, user friendly perspective when
operating Windows, Internet Explorer and Outlook Express. The book outlines
concepts and procedures, while providing a solid understanding of the Windows
operating system.
Theories are further applied to illustrate how hardware and software coexist
within the Windows realm. In each chapter, solutions to common dilemmas are
presented which help to increase user productivity.
This e-book is written at a beginner-to-intermediate level. The following chapter
introduces basic Windows concepts and exemplifies how objects are
manipulated.
This knowledge builds a solid foundation as concepts are
reintroduced throughout the e-book.

HOW TO USE THIS E-BOOK
This book was produced with Adobe Acrobat version 5. Adobe Acrobat offers
document portability on IBM and Macintosh platforms. Because of Acrobat’s
many features, it is widely used in conjunction with e-books and computer
manuals.
This section will briefly explain a few of the most important functions used in
Acrobat.
The Hand Tool is used to click on links within the document, and is also
used move a page vertically.
When the Hand Tool is over top of a link, it turns into a pointer. When a
link is clicked, the document will move to another section of the book
relevant to the link. All links in this document are underlined in blue.
To move back to the previous section of the book after a
link is selected, click the right mouse button to bring up a
dialogue box and select Go to Previous View.

Use the Zoom-in Tool to increase the document view size. Click the right
mouse button when using the Zoom-in Tool for additional view sizes.
Click the Print icon to send the document to your printer.
Any phrases written in red refer to a picture next to the phrase. (Actions,
phrases, or words, written in green with a round bracket around them) refer to
Windows XP users only.
Words written in bold imply a special action, or refer to a key phrase
presented in the Glossary. The Glossary is located at the end of the book.

KEEP UP TO DATE ON CURRENT TECHNOLOGY
New Windows tips and tricks are discovered every day at infopackets.com.
To stay current with the latest buzz in technology information, be sure to
subscribe to our free newsletter: the Infopackets Gazette.
The Infopackets Gazette features Windows tips and tricks, hardware and
software reviews, guest articles, and more.
Don't be left in the dark... use the form on the right to subscribe today!

http://www.infopackets.com/windows+newsletter.
htm

AMENDMENT: Windows XP Users
Please read carefully
Originally, the Windows Primer e-book was created with respect to Windows 95,
98, ME, NT and 2000 operating systems. Since the creation of the Windows
Primer, Microsoft has released their latest operating system, Windows XP. In
light of this, the Windows Primer has been modified to specially suit Windows XP
users.
Since Windows XP is the sum of all previous versions of Windows, almost all
operations defined in this e-book are identical to Windows 95, 98, ME, NT and
2000.
However, there are some discrepancies. Any notable differences for Windows XP
users with regards to procedures or menu dialogue have been are represented
with a green colored font with brackets around the actions, word, or phrase.
For example, if you see (green text in a round bracket), it would describe a
Windows XP only action, word or phrase.
Pictures in this e-book may not appear exactly the same on Windows
XP, but are very similar
Most of the pictures included in the Windows Primer e-book were made with
Windows 2000 (which is similar to Windows 95, 98, ME, and NT).
All pictures in this e-book refer to some action, word, or phrase. Windows XP
users will find slight discrepancies in some of the pictures when comparing a
picture to an action, word, or phrase being described.
While most pictures used in this e-book match almost exactly what Windows XP
presents, any notable changes referring to the picture will be described in the
text having the (green text in a round bracket).
Click here for an example of the Display Properties picture which has
accompanying (green text in a round bracket) to infer a Windows XP action.

TABLE OF CONTENTS
CHAPTER 1: Windows Navigation
i. Objects and Their Type
ii. The Mouse
iii. Icons
iv. Cut and Paste Techniques
v. A Window Defined
vi. Other Ghosted Objects
vii. Slider Bars
viii. Scroll Bars
ix. Minimize, Maximize, And Close Windows
CHAPTER 2: The Desktop
i. Screen Resolution
ii. Desktop Organization: Deleting, Moving, And Shrinking Icons
CHAPTER 3: Other Aspects Of The Desktop
i. The Recycle Bin
ii. Screen Savers
iii. Personalizing the Desktop: Backdrop Images
iv. 16, 24, and 32 Bit Color Depth
v. Placing Shortcuts on the Desktop
CHAPTER 4: The Start Menu
i. The Location of the Start Menu
ii. Modifying the Start Menu
iii. Renaming Icons
iv. Deleting Icons
v. Grouping Icons by Function
vi. Sort Contents Alphabetically
CHAPTER 5: The Startup folder
i. How the Startup folder Effects Windows Boot Time
ii. How to tell what’s in your Startup Folder

CHAPTER 6: Internet Explorer
i. Obtaining an Updated Version of Internet Explorer
ii. Setting the Home Page
iii. Organizing Favorites
iv. Temporary Internet Files
v. Maintaining Temporary Internet Files
vi. Specifying Spaced Used by Temporary Internet Files
vii. Supplementary Internet Explorer 5.5 Video Tutorial
CHAPTER 7: Outlook Express
i. Obtaining the Latest Version of Outlook Express
ii. Outlook Express as a News Client
iii. Setting up a News group Account
iv. News Group Subscriptions
v. News Group Etiquette
vi. Outlook Express As an Email Client
vii. Setting up an Email Account
viii. Setting up Multiple Identities on Outlook Express
ix. Origins of Spam
x. How To Report Spam
xi. Message Rules
xii. Supplementary Outlook Express 5.5 Video Tutorial
CHAPTER 8: Windows Security and Stability
i. Microsoft’s Windows Update
ii. A Software Firewall
CHAPTER 9: Windows Performance Tips
i. The Windows Registry
ii. Hard Drive Maintenance
CHAPTER 10: Other Hardware Performance Tips
i. How RAM Increases Windows Performance

CHAPTER 1: Windows Navigation
Navigation is consistent throughout Windows by the use of object manipulation.
Since all programs rely heavily on similar manipulation methods, this chapter
presents an essential cornerstone of learning.
i. Objects and their Type
All things defined within Windows are considered an object. An object can be
an icon, a sound file, a window, a picture, etc. All objects perform a specific
function and are limited by their type.
An object type describes the nature of the object; it describes rules and
boundaries. Objects are able to communicate and manipulate each other
depending on their type.
For example, an object consisting of type icon is known simply as an icon to
Windows. Object type defines what actions may be performed on the icon, such
as: execute, delete, rename, move, cut and paste.
What happens when an icon is deleted is much more complex than what is seen
by the user. Specifically, before an icon is placed in the recycle bin, it must
communicate with the recycle bin before it is manipulated in any way.
Before the icon is accepted or rejected to the recycle bin, its type is matched
against the recycle bin type. If the icon is not allowed, the recycle bin rejects
the object.
This is demonstrated by attempting to move the My Computer icon to
the recycle bin. Obviously, this is erroneous and cannot be done.
This also explains why some objects can be manipulated in a specific way, while
other objects cannot.

ii. The Mouse
The mouse is an input device used to navigate Windows. Most modern mice are
equipped with two buttons and a scroll wheel.
The Left Mouse Button
The left mouse button provides Windows with three primary functions: select,
drag, and execute.
A single left-click will select or highlight an object.
An object is dragged with a click-and-hold technique. Place the left mouse
button over top of an object, click, hold, and drag to its new destination.
To execute an object, simply double-click it.
The left mouse button is commonly referred to as a “single click, left-click,”
and sometimes, just “click.”
The Right Mouse Button
The click of a right mouse button provides a special Menu, referred to as a
dialogue menu. The dialogue Menu is always different and depends on
what object is underneath the pointer when right-clicked.
For example, right-clicking an icon will produce a different Menu when
compared to right-clicking an empty area of the Desktop.
The right mouse button is always referred to as a “right-click.”
The Scroll Wheel
The scroll wheel on a mouse is an invaluable tool when surfing the Internet. It
moves screen contents up and down without the need to use a scroll bar.

iii. Icons
An icon is an object which represents an executable function. Icons symbolize a
picture, and function based on its relation to the picture.
For example, the My Computer icon looks like a computer; when double
clicked, it accesses a list of files stored on the computer.
Icons are manipulated in a variety of ways. A single left-click of an icon will
select it. Comparably, a single click on the text of an icon will rename it. To
move an icon, drag it with the left or right mouse button. Double click an icon to
execute its function.
A right-click of an icon will invoke an object Menu dialogue. Furthermore, an
object which is right-clicked, held, and dragged will produce a Menu dialogue for
an advanced move. It provides options to: Copy, Move, Create a Shortcut, or
Cancel.
iv. Cut and Paste Techniques
Objects are also moved using the cut and paste technique. When an object is
“cut”, it is placed into the clipboard – a temporary holding area. When it is
time to paste the object, the object is released from the clipboard to its new
location.
Cut
To place a movable object in your clipboard, place the mouse over top of the
object, right-click, and select Cut. The object will appear grey, or “ghosted”
when successfully placed into the clipboard.
To place multiple objects in the clipboard, navigate the mouse and position it
before any one of the objects. Next, hold down the left mouse button and drag
the mouse to create a square-like selection area around the desired objects.
Next, right-click over one of the selected objects and choose Cut. If done
successfully, all selected objects will appear ghosted.

Paste
Object types must match before attempting to paste to a new location. For
example, Windows will not paste an icon into a word processor document
because the object types do not match.
To release an object from the clipboard, navigate to the desired location, rightclick, and select Paste.
v. A Window defined
A window is an object which represents an executed task. A window can be a
file listing, an internet browser, or a word processor. Microsoft named its
operating system “Windows” because of the ability to execute more than one
instance of a Window at any time. This is referred to as multitasking.
vi. Other Ghosted Objects
Some objects (including menu dialogue text) ghost themselves if they are not
allowed to be modified or executed, unless another action is performed first. For
example: The Apply Button in a window will appear ghosted until an object inside
the window has been manipulated.
vii. Slider Bars
A slider bar is used to enhance Menu dialogue. Mostly, a slider bar is used to
increase or decrease the value of an object. An example of a slider bar is used on
the volume control.
viii. Scroll Bars
Scroll bars move window content horizontally and vertically. A horizontal scroll
bar is located on right hand side of a window; a vertical scroll bar is located at
the very bottom of a window.
To move a scroll bar, left-click, hold, and drag the mouse in the desired direction.
ix. Minimize, Maximize, And Close Windows
The minimize, maximize, and close objects are located at the top right of a
window and provide three different functions. The flat dash button on the far left
will minimize a window, the button which looks like two cubes will maximize a
window, and the button with an x will close a window.

CHAPTER 2: The Desktop
Among other functions, the Windows Desktop is home to many icons. The
philosophy of the Desktop is to present an elite list of icons which are quickly
referenced and launched, requiring minimal search effort.
However, this ideology is lost when references of newly installed programs are
placed on the Desktop. The Desktop can quickly become cluttered as the list of
installed programs grows. Similarly, the time to search for a desired program
intensifies.
In contrast, the Start Menu recites a comprehensive list of all installed
programs. Since Desktop space is precious, only a select number of icons should
be referenced here; all other icons can be referred to in the Start Menu.
There are many ways to free precious Desktop space. In this chapter, different
methods of Desktop management are explored.
i. Screen Resolution
Screen resolution is defined as the amount of information able to fit on a
display. Common display resolutions include: 640x480, 800x600, 1024x768, and
coincide with monitor size. Monitors which support 640x480 are referred to as
VGA-only; monitors which are able to display resolutions greater than 640x480
are known as "Super VGA" or SVGA and can display both VGA and SVGA
modes.
Increasing screen resolution is effectively the same as "zooming out" the lens of
a camera; a greater view of the surrounding area is seen, however, the subject
appears smaller and perhaps a bit out of focus. This effect is the same on a
monitor when screen resolution is increased: the icons and fonts are smaller, but
there is more Desktop space to work with.
Screen resolution should be defined on monitors which are a certain size. For
example, a 14" SVGA monitor should use 640x480 resolution for best viewing,
although it may be capable of displaying higher resolutions (up to 1024x768).
Below is a suggested list of screen resolutions for corresponding monitor size.
14"
14"
15"
17"
19"
21"

VGA
SVGA
SVGA
SVGA
SVGA
SVGA

640x480 only
640x480
800x600
800x600
1024x768
1024x768

The true display size of a monitor size can be found
by measuring the viewable area of the screen
diagonally from corner to corner.
This
measurement does not include the border around
the viewable area.
While the above list is only a suggestion, some may
find preferential viewing at much higher resolutions.
To change your display resolution, right-click on an
empty area of the Desktop and select Properties.
Navigate to the Settings Tab and use the slider
bar under the Screen Area (Screen Resolution)
heading to increase your resolution.
ii. Desktop Organization: Deleting, Moving,
and Shrinking Icons
a. Removing Unwanted Icons
When a program is installed, a reference to that
program is often placed on the Desktop. The
reference – commonly referred to as a shortcut
icon – is an icon which refers to the real location of
a program. When a shortcut is double-clicked, a program is executed. Shortcuts
are recognized by a unique, small white box and black arrow located near the
bottom left of the icon.
One of the easiest ways to clean a cluttered Desktop is to remove all infrequently
used shortcuts. Locate any shortcut icon on the Desktop, highlight it with a
single left mouse click, and press the delete key. This will remove it from the
Desktop and place it in the Recycle Bin. Right-click over the Recycle Bin and
select Empty Recycle Bin to permanently remove the shortcut from your
system.
If you’re having a hard time deciding which shortcut icons to remove, try clearing
away any shortcuts which duplicate a similar task as another program. For
example: If there are two word processor shortcuts placed on the Desktop,
delete the one that is used less.

b. Organizing with Folders
One viable alternative to deleting shortcuts is to group related icons together and
place them into categorized folders on the Desktop.
To create a shortcut, place the mouse over an empty area of the Desktop, rightclick, and select New and then Folder. Type in the new folder name and press
Enter.
To select multiple icons one-by-one and move them into a folder, hold down
the CTRL key on the keyboard and left-click each icon to be moved. While still
holding the CTRL key, repeat the process until all icons have been selected.
Next, right-click, hold and drag the last highlighted icon to the newly
created folder. Finally, release the Button and select Move Here. It should be
noted that icons such as the Recycle Bin and Network Neighborhood are not
meant to be moved and must remain on the Desktop.
c. Shrinking the Icons
Another way to increase space on the Desktop is to change the size of the icon.
The Windows default icon size is equal to 32. Although Windows will let you
choose almost any icon size, it must be proportionate to its original size of 32 or
it will appear distorted. An icon size 16 is proportionate to 32, and also happens
to be the smallest size allowed by Windows.
Before changing icon size, ensure that the Auto Arrange Icons feature is
turned on; otherwise, any change made to the size of the icons will cause them
to align improperly on the Desktop. To turn this feature on, right-click over an
empty area on the Desktop and select Arrange Icons and then Auto Arrange.
Right-click on the Desktop again and select Properties this time. The Display
Properties window will appear; select the Appearance Tab at the top
(Windows XP users must also click on the Advanced button to access the
Advanced Display menu).
Next, click the pull-down box under Item, and choose Icon. To the right of
Icon is an option for icon Size. Change the icon Size from 32 to 16. Below
the Menu option Icon, Font Type and font Size is shown. Change the Font Type
to Tahoma, and font Size to 10. If Tahoma font is unavailable, use Arial.
Go back to the pull-down box under Item and select Icon Spacing
(Horizontal). Change its size to 113. Next, use the Item pull-down box and
select Icon Spacing (Vertical), and change the size to 62.

Click on the Apply Button (OK and then Apply) to see the changes. There
should be a noticeable difference in the amount of space available on your
Desktop. If you think the icons are too small, change the size back to 32, or try
increasing the font size of the icons.

CHAPTER 3: Other Aspects Of The Desktop
i. The Recycle Bin
The recycle bin is an icon which looks like a trash-can and is used as a
temporary holding area for deleted data. Within the recycle bin, data can be
recovered if accidentally deleted, or can be permanently removed from the
system. Once a file has been removed from the recycle bin, it is gone
forever unless a special data-recovery program is used.
By default, Windows will allocate 10% of your entire hard drive space for storing
temporary deleted data. This amount of space is variable and may be defined;
independent configurations are allowed for systems with multiple hard drives, or
a single, global setting can be specified for all drives. Alternatively, the recycle
bin can be set to delete files immediately without sending them to the recycle
bin.
To modify your recycle bin settings, navigate to the Desktop, right-click over top
of the Recycle Bin, and select Properties. Follow the dialogue and configure
the recycle bin to your liking.
ii. Screen Savers
The initial purpose of a screen saver was to save a monitor from burning an
image into its screen when left idle for too long. This was the case for
computers which ran for 24 hours a day with their monitor continually powered
on, leaving a footprint of a main Menu burnt into the screen. Similarly, image
burning is evident on older bank machines and arcade games where a faint
representation is displayed but is not really there.
Is your computer a candidate for a screen saver? The answer depends on
whether or not your monitor supports an energy saving mode. The power
saving ability allows the monitor to switch to a standby mode, which reduces
power consumption and blanks the screen – saving the display from image
burning.
To modify your screen saver and energy saving function, navigate to the
Desktop, right-click on an empty area, and select Properties. On the Display
Properties window, select the Screen Saver Tab.
A monitor can be tested for energy saving capabilities by clicking on the Power
Button under the heading Energy Saving Features Of Monitor (Monitor
Power). Next to the Turn Off Monitor dialogue, specify a setting of After 1
Minute.

Finally, click Apply, OK, and then OK to close the Display Properties Window.
Wait 1 minute without touching the mouse or keyboard to see if the monitor
switches to standby mode. If nothing happens after 1 minute, the monitor does
not support energy saving capabilities.
Monitors that do not support this ability can be forced to use a Windows
screen saver. Below the Screen Saver tab on the Display Properties
window, choose a favorite screen saver and specify the amount of system idle
time until the screen saver becomes active. This option will work on all monitors
regardless if it supports energy saving capabilities, and will save the display from
image-burning.
iii. Personalizing the Desktop: Backdrop Images
Placing a picture on the background of the Desktop is a great way to personalize
Windows – however, it also causes the system to lag. This is especially
prominent on systems which are equipped with video cards that have small
amounts of video memory.
When a backdrop image is used on the
background of the Desktop, the video card must
process it along with every screen change that takes
place.
The job of a video card is to input
information from the computer, process the
information from its video memory, and output the
changes to the display.
Since video cards come with a finite amount of
video memory, it must continually process new
information.
Computers equipped with larger
amounts of video memory (32 megabytes and
higher) are able to keep information resident in
their memory longer. This eliminates the amount of
requests for new information when video memory is
depleted, allowing for smooth video transition.
As a general rule of thumb, an acceptable backdrop
image size consists of a file size no larger than 3060k in size. Images which can produce a repeated
pattern are most favorable in comparison to using a
single, large image as a backdrop.

To specify a backdrop, right-click over an empty area of the Desktop, and select
Properties. The Background Tab will already be selected (Windows XP users,
must navigate to the Desktop Tab); choose from a pre-selected list of backdrop
images that come bundled with Windows. Experiment with each image using
Center, Tile, and Stretch from the Picture Display (Position) pull-down Menu to
determine what you like best. Don’t forget to click Apply to view your changes.
iv. 16, 24, and 32 Bit Color Depth
Windows provides the choice of 16 bit, 24 bit, and 32 bit color display modes.
The “bit” suffix is simply a unit of measurement; only the value is important
when differentiate the modes. It is said that the human eye can only distinguish
approximately 6 million different colors. 16 bit color is equivalent to 65,536
colors; True Color (also known as 24 bit) can display 16,777,216 colors - which
are far more than the eye can detect.
So, what is the purpose of 32 bit color? Technically, 32 bit color has an
additional 8 bits of color used for an Alpha Channel. For the scope of this
discussion, such technicality is not required. What is important is that 32 bit is a
larger number than 24 bit, and that the human eye can distinguish less color
than either can display.
To the computer, however, 16 bit color varies definitively from 24 or 32 bit. In
an abstract sense, all three color modes can be compared using an analogy of
traffic on a highway. For this example, information sent to a video card is
represented by traveling cars. Computer resource required to handle the traffic
is represented by the highway. A 16 bit highway has only 1 lane of traffic; a 24
bit highway is equivalent to 1.5 lanes, and a 32 bit highway has 2 lanes. It
would follow that a greater amount of traffic requires more highway to be used.
In the physical world, a video card in 16 bit color mode must work twice as hard
to display the same image in 32 bit. Since a human can only distinguish 6 million
colors at a time, 32 bit color is a waste of precious computer resource. Notably,
a computer can work much faster in 16 bit color than in 24 or 32 bit color mode.
The difference in time to process images is highly noticeable on older computer
systems when comparing bit depth of large images.
To check the color depth of your system, right-click on an empty area of the
Desktop, select Properties, and choose the Settings Tab. Look under the
heading Colors (Color Quality) and make sure that 16 bit color is selected
for optimal video performance.

v. Placing Shortcuts on The Desktop
Other than housing icons, the Desktop can provide shortcuts to regularly visited
system folders. Placing a shortcut folder on the Desktop can eliminate the
number of mouse clicks normally required to navigate to a desired system
directory via My Computer.
Although any shortcut folder can be used as an example, creating an instance to
a download folder on the Desktop is a great way to reduce mouse clicks, and
provides quick and easy access to all downloaded files. Another advantage to
placing a shortcut folder on the Desktop is the instant access it offers via the
Desktop icon in any Save As dialogue window.
To create download folder, navigate to the Desktop and double click on My
Computer. Double click on the hard drive (usually C drive) which will store all
of your future downloads.
In the window of the hard drive you have selected, right-click on an empty area
to bring up a Menu; select New and then Folder; label it “Downloads”. Move
the hard drive window so that a visible area of Desktop is available. Drag the
new folder to the Desktop with the right mouse button. Release the mouse
Button and select Create Shortcut Here. This will place a shortcut on the
Desktop to your download folder.
It is important to reiterate that the new shortcut does not store downloaded files
to your Desktop; it merely points to the location of the download folder, but is
accessible from the Desktop.

CHAPTER 4: The Start Menu
The purpose of the Start Menu is to provide navigation to a list of installed
programs, including special utility programs which come bundled with the
Windows operating system.
While the Start Menu is the primary navigation tool for launching a program, it can
be difficult to navigate as more programs are added to the system.
This chapter will discuss multiple ways of managing your Start Menu, so that you
can find programs quickly and easily.
i. The Location of the Start Menu
On a new installation of Windows – and for most users – the Start Menu is
located at the very bottom left of the display and is executed with the left mouse
button. When the Start Button is pressed, a list of folders and icons are
displayed. The mouse is used to navigate through the list of files and folders; a
program can be executed with another left-click.
ii. Modifying the Start Menu
To modify the contents of the Start Menu:
Win95/98/NT users: click the Start Menu Programs Tab and then the
Advanced Button.
WinME, 2000 users: left-click the Start Menu, Settings, and then Taskbar
and Start Menu. Next, click the Advanced Tab and then the Advanced
Button.
WinXP users: right-click the Start Menu and select Explore All Users.
If you have multiple people sharing one computer, you may have to
Explore other directories below the All Users folder to modify the Start
Menu (as seen with the <Another User Name> Folder). This also
holds true for Windows XP, 2000, and NT users, with respect to
system configuration.
Depending on your operating system, any of these three methods will bring up a
new window with Explorer and the Programs Folder will be listed. Double click
on the Programs Folder (as seen highlighted in the above picture) to bring up
the list of installed programs.

The next few sections will discuss how to rename, delete, and sort programs by
function in the Start Menu.
iii. Renaming Icons
To rename an icon, left-click once to highlight it. Next, right-click over top of the
selected icon and choose Rename. Type in the new name of the icon and press
Enter.
iv. Deleting Icons
To remove an icon, left-click the icon to select it, and press the delete key (not
the backspace key) to send it to the recycle bin. Deleting a shortcut icon from
the Start Menu will not remove the program permanently – it will only remove its
presence.
To uninstall a program, click Start, Settings, Control Panel, and then double
click Add/Remove Programs (Start, Control Panel, and then select Add or
Remove Programs). Navigate through the list of installed programs and select
the program to uninstall.
v. Grouping Icons By Function
The Start Menu can shrink dramatically in size by grouping related programs in a
folder. For example, the creation of a folder called "Internet" may be used to
store all Internet-related programs.
To create a new folder, left-click on File Menu and select New and then Folder.
Type in the folder name and press Enter. Icons can be moved into the new
folder using cut and paste techniques.
vi. Sort contents Alphabetically
The contents of the Start Menu can be sorted alphabetically by clicking Start
and then Programs. Right-click on any icon in the Programs list and select
Sort By Name (Windows XP sorts Start Menu programs automatically).

CHAPTER 5: The Startup Folder
The Startup Folder is a special Windows folder which executes any program
placed in its folder every time Windows starts.
In this chapter, we will discuss how the Startup Folder is related to
deteriorating Windows performance.
i. How the Startup Folder Effects Windows Boot Time
Sometimes when a program is installed, its icon is placed in the Startup Folder so
that it will be executed every time Windows boots. The probability of a program
creating a shortcut of itself in the Startup Folder increases with the amount of
programs installed on a system. Simply put: with fewer programs in the Startup
Folder, the faster Windows will load.
ii. How to Tell what's in your Startup Folder
To see what is in your Startup Folder, click the Start Menu, (All) Programs,
and then Startup. This will open the Startup Folder window and display a list of
shortcut icons. If there aren’t any icons listed, don't worry – your system does
not require any tweaking. If there is a list of icons in the Startup Folder, there is
a good possibility that removing them will shave seconds or perhaps minutes off
of Windows boot time.
Primarily, most programs do not require special “boot time loading” in order to
execute successfully – almost all programs remain dormant until executed.
However, there are some programs which require a special initialization process,
which is done at boot time with the use of the Startup Folder.
A simple test can be used to determine if a program will function without having
to be executed at boot time. This is done by taking the contents of the Startup
Folder and placing it into a temporary folder. If any program is unable to
function after it is removed from the startup, the shortcut can be returned via
the temporary folder.
To create a temp folder, right-click on an empty space on the Desktop, and
select New and then Folder, and call it "temp startup". Next, drag all of the
shortcut icons in the Startup Folder into the temporary folder on the Desktop.
The Startup Folder is located in the Start Menu, and can be access via Explorer.
See chapter 4.ii for details.

After moving all shortcuts, reboot the system. Click Start, Shutdown (Turn
Off Computer), and then Restart. If Windows is able to load without a
problem, and each of the programs listed in the temporary folder continue to
function, they can be removed permanently from the system. If this is the case,
remove the temporary Startup Folder from the Desktop by left-clicking once on
the folder and press the Delete key.

CHAPTER 6: Internet Explorer
Internet Explorer is a major component of the Windows operating system.
Microsoft made it such a major focus that many of the features from Internet
Explorer are built into almost every aspect of the operating system. Therefore,
Internet Explorer should be updated regularly to maintain security and stability.
i. Obtaining An Updated Version Of Internet Explorer
To update Internet Explorer, go to http://windowsupdate.microsoft.com.
Navigate through the site and click on the link for an update to Internet Explorer
(Pick updates to install). After upgrading explorer, download the Critical
Update Packages. They contain vital security updates and patches for
Windows. This will be discussed in detail in chapter 8.
ii. Setting the Home Page
One of the most frequently used options of Internet Explorer is the home page.
The home page is the first web page displayed when Internet Explorer is
launched. Often, this setting is overwritten when newly installed software (such
as ICQ) overwrite the home page setting.
To specify your own home page, load Internet Explorer, click on the Tools
Menu, and choose Internet Options. Under the General Tab, there is a
dialogue box to set the home page. Type in your favorite web site address, and
click Apply and then OK to save changes. The new home page can be accessed
by clicking on the Home Button icon, located near the top of the browser.
iii. Organizing Favorites
Internet Explorer Favorites are used to keep track of frequently visited and
important web sites. Over time, as more Favorites are added, the Favorites
Menu becomes muddled and difficult to navigate.
To manage your Favorites, click on the Favorites Menu and choose Organize
Favorites. The icons can be organized in the same manner discussed in
sections 4.iii, 4.iv, and 4.v.
iv. Temporary Internet Files
A web page consists of many small files that make up an entire site, all of which
are collected and stored on the computer. Files sit dormant until a site is
revisited, after which, they are recalled and loaded rather than re-downloaded,
saving download time.

Temporary internet files can eat away at valuable disk space on a computer if
not maintained, and should be a part of regular PC maintenance.
v. Maintaining Temporary Internet Files
To remove Temporary Internet Files, load Internet Explorer and click the Tools
Menu and select Internet Options.
Under the General Tab, select
(Temporary Internet Files) Delete Files. Check mark Delete All Offline
Content, and press OK to remove all the files from your system.
vi. Specifying Spaced Used by Temporary Internet Files
The amount of space used by Temporary Internet Files can vary, depending on
how much you want to set aside. A large amount of space allotted to Temporary
Internet Files will ensure that web pages are downloaded quicker. This is due to
the likely chance that a required web page file is located on the system and will
not require downloading. In computer terminology, this is also known as a
buffer or cache.
To specify the amount of space used by Temporary Internet Files, load up
Internet Explorer, left-click the Tools Menu, and select Internet Options.
Under the General Tab, select the Settings button under the Temporary
Internet Files heading. Next, specify the amount by typing a number (in
megabytes), or use the slider bar. Click OK to save changes.
vii. Supplementary Internet Explorer 5.5 Video Tutorial
A supplementary video tutorial on Internet Explorer is available from our website.
It provides an overview of common features used under Microsoft's Internet
Explorer 5.5. Topics include: proper screen resolution, how to update Internet
Explorer, the button toolbar, setting the home page, organizing favorites with
folders, and backing up favorites to a floppy disk.
The web page can be access by clicking on the link:
http://www.infopackets.com/windowstutorials.htm

CHAPTER 7: Outlook Express
Outlook Express supports dual functionality as both an email and a news
client. Since email is the stronghold of Outlook Express, it will be the primary
focus in this chapter of the e-book. Also included at the end of the chapter is
an extensive discussion about spam and how to combat it.
i. Obtaining the Latest Version of Outlook Express
The latest version of Outlook Express comes coupled with Internet Explorer and
is obtained by visiting Microsoft’s Windows update website. See chapter 6.i for
details.
ii. Outlook Express as a News Client
News groups provide internet-wide discussions featuring a variety of topics. The
news group reader provided by Outlook Express is very similar to reading an
email, except messages are presented online, rather than sent privately.
Messages are presented with a single header consisting of a topic, date, and the
author. Some messages may contain a thread, consisting of a replies pertaining
to a specific topic.
Threads are displayed next to a message subject and are distinguished by their
light grey square with a plus sign in the middle. When the Thread Button is
clicked, the topic expands and collapses.
iii. Setting up a News Group Account
To set up a news group account, launch Outlook
Express. Left-click the Tools Menu and select
Accounts. A new window will appear; on the top
right, click the Add Button, and select News. This
will start the Internet Connection Wizard.
Display Name
A display name is shown to anyone who reads both
public and private messages shared in a news
group.
Type in your display name and click Next to continue.

Internet News Email Address
In order to prevent unsolicited email (spam) from being sent to your mailbox, it
is recommended that you do not share your email address with the public.
If you decide to display your email address on the news groups, it should be
modified so that the address is decipherable by a human, but useless to an
email harvester. An email harvester collects email addresses in news groups
for the purpose of sending unsolicited emails.
For example, if your email address is ted@home.com, modify it to read
tedNOSPAM@home.com.
Most users from the news groups are fully aware of email harvesters, and are
able to decipher your address by excluding the NOSPAM part of the email.
Click Next to continue.
Internet News Server Name
A news server name is the name of the machine which provides news group
messages. All news server names differ from each internet service provider
(ISP), and me be available from your ISP’s web site, or on a piece of paper you
received when you first set up your internet account.
A common news server name is “news”. This is an acronym for the real news
server name provided by your ISP. When used, the name is decoded when
accessing the news groups and is converted automatically into the proper news
server name.
If you are unable to locate your news server name, call your ISP and ask for
help.
Click Next to continue.

Congratulations
Click Finish to save your settings.
Outlook Express will now receive a list of news groups available from your
news server. After clicking Finish, a dialogue box will appear and ask whether
or not to download a list of news groups. Click Yes
to obtain the list. This can be a very lengthy
process, as there are literally thousands of news
groups available.
iv. News Group Subscriptions
After the news group names have downloaded, navigate to the heading Display
News groups Which Contain, and enter a word or phrase containing a topic
of interest. Outlook Express will search for a list of related news groups; doubleclick on each news group of interest underneath the heading News group to
subscribe. Repeat the process until you are satisfied with the amount of
subscribed groups.
By default, the Folders View should be enabled under Outlook Express
and is located at the far left of the screen. It contains personal folders
such as the Inbox, Outbox, Sent Items, Deleted Items, and Drafts. If it
is not present, choose the View Menu and select the check box Folder
List and click OK.
The Folders View should now include a new section containing your
news group server name. Left-click this area to collapse or expand the
subscribed list of news groups.
Click on each news group to begin downloading message headers. Since it
would take a long time to download all the messages and their contents, only
the title of the message is downloaded; this is referred to as a message
header. To read a message, click on a message header. Messages from
newsgroups are presented on the screen in the same location as an email
message in Outlook Express.
You can begin posting a message to the newsgroup by clicking on the New Post
Button. Your message will be displayed to everyone on the Internet who visits
that particular news group.

v. News Group Etiquette
In cyberspace, there are a few unsaid rules that should be followed when
posting public messages in a news group:
1. Never TYPE WITH YOUR CAPS LOCK ON. This is considered yelling.
2. Try to remain on topic when responding to a message.
3. Don’t use harsh language, and never flame someone. Flaming is referred
to as online public humiliation, and is not tolerated by news group
moderators.
4. If you have a question to ask about the group, try searching for a group
FAQ (frequently asked questions) before posting your message.
5. The title of an original post should be clear and concise if you want
anyone to respond to your message. Ambiguous messages like “How do I
…” don’t get read.
6. Always ask nicely for help. Never demand it.
7. Never, ever post the same message to more than 2 or 3 groups at a time.
Otherwise, it will be considered as news group spamming. If you feel the
need to post the same message in different discussion groups, wait a few
days between posts and change the title of the message.
8. When replying with Outlook Express, always use Reply To Group (Reply
Group), and not Reply To Sender (Reply). Most people don’t use a
valid email address for fear of having it collected by an email harvester.
9. Wait a few minutes (depending on your ISP) for your message to post to
the news group before it appear on Outlook Express. Also keep in mind
that it will take hours or days before your message propagates to other
news servers across the Internet, so don’t expect an immediate response
to your message.
vi. Outlook Express as an Email Client
Electronic mail is a convenient, instantaneous way to send personal letters and
small files over the internet. Outlook Express is a highly configurable email client
and is able to process multiple email and news group accounts at the same time,
or can be personalized for separate identities with password protection.
In the next few sections, both scenarios are considered.

vii. Setting up an Email Account
Setting up an email account is very similar to setting up a news group account.
Click the Tools Menu and select Accounts to open the Internet Accounts
window. Next, click the Add Button and select Mail to begin the Internet
Connection Wizard.
Detailed account information from your Internet Service Provider (ISP) is
required to finish the setup. This information would have been available at the
time of purchasing your Internet account.
Your Name
This is the name that will appear to any recipient of an outgoing email. Type in
your first and last name and click Next.
Internet Email Address
Click the Button which reads, “I Already Have An
Email Address I'd Like To Use”. In the prompt
below, type in the email address provided by your
ISP. An email address should contain the format:
yourName@yourDomain.com. If you don’t know
what your email address is, call your Internet
Service Provider for help.
Type in your email address and click Next.
Email Server Names
This section requires two areas of input. The first is
the Incoming Mail Server: this is where email
resides until it is sent to a recipient. The second input box is the Outgoing Mail
Server: email is processed here before sent to a recipient’s incoming mail
server.
Both Incoming and Outgoing Mail Servers are defined by your Internet Provider,
and may be referred to as a POP/POP3, IMAP, or HTTP mail server.
Type in the name of your Incoming and Outgoing Mail Server and click Next.

Internet Mail Login
A login name and password is required to access both incoming and outgoing
mail servers, and is used to prevent others from accessing your email.
With the information provided by your ISP, type in your Account Name and
Password, and click Next.
Note: If you do not specify a password here, you will be prompted later to
specify one when checking for new email. This is a good way to password
protect your email from others – but only works when new mail is checked.
Congratulations
Click Finish to save your settings.
To ensure proper setup, the account needs to be tested. This is done by sending
a message to yourself.
To begin, click New Mail Button (Create Mail) at the top left of Outlook
Express. Type your email address in the To: area. Press the TAB key on the
keyboard 3 times to move the cursor to the body of the message and type in
"Hello". Click on the Send Button to finish.
If the account was set up properly, the message will be delivered to your
Outgoing Mail Server. To check for the sent message, wait a minute and click on
the Send and Receive Button (Send/Recv).
The Folders View is located at the top left of Outlook Express. Make sure that
the Inbox is selected to check for any incoming messages. If your message is
received in the Inbox, the email account was successfully set up. If does not
appear, you may have to wait a few more minutes for the message to come full
circle.
The Send And Receive dialogue box will inform
you of any configuration errors if it was unable
to complete its process. In this case, close the
Send And Receive window and re-check your
configuration settings. To ensure validity, click the
Tools Menu, select Account and click the Mail
Tab. Double click your mail server to review the
settings.

viii. Setting up Multiple Identities on Outlook Express
As mentioned earlier in this chapter, Outlook Express can be configured to
process multiple email and news group accounts at the same time, or can be
configured with private, password protected identities.
Scenerio 1
Outlook Express can be configured to process multiple accounts at the same time
when the Send and Receive button is clicked. To add another email account
to outlook express, simply run the Internet Connection Wizard again. All the
information discussed before would remain the same, except the Display Name
and Email Address would be different for the new account.
Scenerio 2
You can also configure Outlook Express to process
multiple accounts separately using an email or
newsgroup Identity.
To set up an identity, click the File Menu,
Identities, and then Manage Identities. Type in
your identity name; without pressing Enter or
clicking OK, decide whether or not you would like to
keep this identity private.
If you do not want anyone else to switch to your
identity and access all of your emails and
newsgroups, you must specify a password.
Click the Require Password check box and enter
your email account password.
Once you choose whether or not to use a password
for your identity, you will be taken straight to the
Internet Connection Wizard to finish the setup.
Switching and Managing Identities
An identity can be switched or managed by clicking the File Menu and then
select Switch Identities. To change to an identity, double click the account to
switch to. To manage an identity, click once on the identity name and select the
Manage Identities Button.

Removing an Identity
Identities can only be removed if you are not currently using that identity. For
example: If you were using identity A and wanted to remove identity A, you
would have to switch to identity B first, then remove identity A.
Removing an identity is done using the Manage Identities window (see above).
ix. Origins of Spam
Sometimes, unsolicited email (spam) is sent to your Inbox. While difficult to
thwart, spam can be reduced using Message Rules. If configured properly,
Message Rules can sort or delete unwanted email before it is read.
Before attempting to block spam, it is essential to understand how spam is sent
and received to recipients. Three methods of spamming are explored.
Method 1: From the ISP
Sometimes, email addresses are collected from an employee of an Internet
Service Provider. With access to thousands of records, an email list is quickly
generated using the ISP central database. The list is then passed on to the
spammer.
Method 2: Email Harvesters
Email addresses are also generated with the help of an email harvesting
program. An email harvester is fully automated and can collect addresses from
each random page it visits. Similarly, harvesters are used in news groups to
collect addresses from publicly posted messages.
Method 3: Mail Server Infiltration
Some spammers use special hacking programs to gain unrestricted access to
local mail servers. Once infiltrated, spam is sent to multiple recipients without
the need to specify a recipient address.
x. How to Report Spam
Mail Headers provide a virtual trail leading back to a spammer, and are hidden
deep within each unsolicited email received. Like a professional thief, some
spammers are able to hide their trail; others are less experienced and leave clues
of their origin.

Network administrators are responsible for dealing with spam complaints. To file
a complaint, mail headers must be sent to the Network Administrator where the
spam message originated.
To view mail headers, right-click over top of a
message subject and select Properties, and then
click the Details Tab. The second line of the
message header will read “Received: from
<some address>”. Highlight this text by holding
the left mouse button, and drag the mouse over top
of the address.
Next, right-click over the
highlighted text and select Copy. This will paste
the text to the clipboard.
Close the mail header window and click on New
Message. In the To: field, right-click the mouse
and select Paste. Modify the address to read
“abuse@<some address>”.
For example, a header might read “Received: from
mh6-tx.mail.home.com ([65.10.73.148])”. The text
“mh6-tx.mail.home.com” is then paste to the To:
field and modified to read “abuse@mh6tx.mail.home.com”.
Next, paste the mail headers into the body of the
outgoing message.
Minimize the message
containing the address abuse@<some address>. Right-click over top of the
spam subject title and select Properties. Click the Details Tab and then rightclick over top of the headers and choose Select All. Right-click again and select
Copy to place the headers in your clipboard.
Go back to the complaint email containing the address abuse@<some address>.
Navigate to the message body, right-click, and select Paste. Finally, click on the
Send Button to transmit your complaint. A response should be received within a
day or two, letting you know if the complaint is being dealt with.
xi. Message Rules
As previously discussed, some spammers can infiltrate a mail server to send
unsolicited email. When this method is used, the sender address is left blank but
the spam is still delivered to a mailbox. In this case, a message filter can be set
to delete all messages which are not a valid email address.

Sample Mail Rule: Delete all messages NOT addressed to you
Click the Tools Menu, and choose Message Rules
and then Mail. Click the New Button and then put
a check mark next to Where the To Line
Contains People.
Under the #3 Rule Description, click the link
Contains People. A new window will appear; click
Type one name at a time ... from the Address
book, and enter your email address.
Underneath the People heading in the same
window, click once to select Where the To Line
Contains People, and then click the Options
Button. Underneath the #1 Rule, select message
does not contain the people below. Click OK to
continue.
Finally, enter the name of the mail rule under the
#4 heading, and type in no valid email address.
The final mail rule should read:
Where the To line does not contain people
"yourName@yourDomain.com" delete it.
All emails directed to your mailbox not containing
your address will be redirected to the Deleted
Items Folder. The mail rule can also be modified
to Delete It From Server so that the message will
not download to your computer.
Using the example above as a guideline, experiment
and create your own message rules.
xii. Supplementary Outlook Express 5.5 Video
Tutorial
A supplementary video of Outlook Express version
5.5 is available from our website:
http://www.infopackets.com/windowstutorials.htm

CHAPTER 8: Windows Security and Stability
It is not surprising to most computer users to find out that Windows is full of
bugs. A bug is a flaw in software which produces unexpected results. Since
Windows is an operating system, it is also classified as software. Some bugs in
Windows can cause unexpected results, such as: a complete system freeze
(also known as a system "lock up"), the Blue Screen of Death (BSOD), or a
spontaneous system reboot for no apparent reason.
The main purpose of Windows is to overlook all operations on a computer and to
ensure all programs function properly. A special set of rules reside in the
computer’s memory which permit Windows to perform operating-system oriented
functions. The functions define interactive rules between the hardware inside
the computer and the software which operates under the control of Windows.
The computer memory containing the special rules is sacred and must never be
compromised by any other program.
Some times, a bug from a program goes undetected and seeps into the sacred
memory area. As previously mentioned, the job of Windows is to oversee all
superfluous operations, so this action should not be allowed. When the memory
is compromised, it causes an unexpected result. Consider this conundrum: If a
bug from a program goes undetected by Windows, it is for the reason that
Windows itself has a bug and was unable to recognize the breach in security.
The next section will discuss how to increase system stability and security so that
bugs do not cause Windows to falter.
i. Microsoft’s Windows Update
Hackers are also responsible for crashing Windows. When a computer is
connected to a network, such as the Internet, hackers are able to infiltrate a
system because of security holes found within the Windows operating system.
Once a hacker gains unrestricted access, anything can happen. Microsoft
provides free Windows updates via their website to correct known security
issues. The updates contain bug patches, increase security and stability, and are
referred to as Critical Update Packages.
They are available by clicking on the link http://windowsupdate.microsoft.com.

ii. A Software Firewall
Critical Update Packages help to guard against hackers, but what if not all
security issues have been exploited? One way of getting around this problem is
by implementing a Firewall.
A good firewall program can be configured to allow communication only on
certain channels of a computer, effectively blocking 99% of all hack attempts.
One of the best known firewall utilities is Zone Alarm, and it’s completely free
for non-commercial use.
http://www.zonelabs.com

For detailed information about How to Stop Hackers and Viruses from gaining
access to your system, be sure to grab our supplemental * FREE * report:
http://www.infopackets.com/hacking+hackers+hack.htm

CHAPTER 9: Windows Performance Tips
i. The Windows Registry
Every program installed to Windows creates an entry into a database called the
system registry. The registry contains information about each program,
including: its location, what files are needed in order for the program to be
executed under Windows (also known as Dynamic Link Libraries, or DLL's), a
list of all files which make up the program, and the like.
Over time, the registry grows as new programs are installed to the system. As
such, Windows boot time increases, and performance degrades.
Some registry entries tell Windows to execute a program every time Windows
starts. Other entries are injected into Windows and install add-ons to the
operating system – even if you are unaware that the option is being installed.
Microsoft is famous for the latter example and is responsible for introducing
programs such as "FindFast.exe", which is part of the MS Office suite. The
idea behind FindFast is to locate all MS Office files stored on a computer so that
it can be found quickly if misplaced. Since the computer is constantly on the
lookout for MS Office files, valuable resources are wasted. The program does
more harm than good because most users store all their office files in the same
location on a computer.
Tip: To uninstall FindFast.exe from your system, click the Start Menu, choose
Programs and then Startup. Right-click the FindFast icon and press the delete
key.
To reduce the possibility of finding programs such as FindFast on your system,
uninstall any programs which are redundant and infrequently used.
This philosophy eliminates the likelihood that a previously installed program was
causing a performance loss.
To view all of the programs installed on your system, click the Start Menu,
choose Settings and then Control Panel (Start, Control Panel). Next,
click on the Add/Remove Programs icon (Add or Remove Programs).
Scroll through the list of programs and remove those which are no longer
needed.

ii. Hard Drive Maintenance
A hard drive is a computer device responsible for storing all programs and
personal data. The inner workings of a hard drive include circular platters used
to store information, with read/write heads located above and below each
platter. Data is written to the hard drive somewhat like a compact disc (CD),
with tracks defining information boundaries.
Due to the physical properties of a hard drive, gaps of unused space are left inbetween records every time information is added
and removed.
For example, a piece of data
containing a unit of 10k may fit in an area on the
hard drive that is 12k wide, leaving 2k of unused
space.
Sometimes, data is too large to fit in one area, and
may need to span multiple locations on the hard
drive. Load time increases as the hard drive must
move its read/write heads to different locations to
obtain one record of information. This scenario
represents how every file is stored on a hard drive
and is responsible for degrading system
performance.
To increase hard drive efficiency, a technique
known as defragging acquires related data and
places it contiguously on the hard drive. This
minimizes the time required to locate and read/write
a file.
The first phase in the defragging process takes a
snapshot of all files on the hard drive. Once a
snapshot is taken, clusters of related data are mapped to areas of the drive
which provide a better “fit”. The procedure repeats until there is no more data
to map.
To access the Defrag utility, click the Start Menu, choose (All) Programs,
Accessories, and then System Tools. Click on Disk Defragmenter to start
the defrag program. Choose the hard drive to defrag (usually C drive), and
follow the Menu dialogue.

CHAPTER 10: Other Hardware Performance Tips
i. How RAM increases Windows Performance
Adding RAM to a computer can dramatically increase Windows performance.
RAM is a temporary holding area for frequently used data. RAM access time is
very fast compared to any other storage medium inside a computer. The
amount of information it can hold at one time is generally much smaller than
what can fit on a hard drive.
Windows is able to process applications faster by keeping frequently used
application data in RAM for a longer period of time. Without sufficient RAM,
Windows is forced to store overflow information to the hard drive. RAM access
time is represented in nanoseconds, compared to milliseconds of a hard drive.
Depending on what operating system is being used, the amount of RAM required
for a particular machine can vary. For a system
running Windows 95 or 98, 64 megabytes of RAM is
sufficient, although 128 megabytes will definitely
process application data much quicker.
For
Windows ME, and 2000, 256 megabytes and higher
is recommended.
To find how much RAM exists in your computer,
navigate to the Desktop, right-click My Computer,
and select Properties. The information displayed
under the General Tab will indicate how much
memory is available (Windows XP users: click
Start, Control Panel, select Performance and
Maintenance, and then choose See basic
information about your computer).
Further consideration is required before purchasing additional RAM for a PC. For
older computer systems, the price of RAM is almost as expensive as buying a
new computer.
As technology advances, newer RAM replaces its aging
predecessors. With a lower supply of older RAM, a higher price will be paid.
The age of a computer can determine whether or not it is cost effective to
purchase additional RAM. As such, processor speed is directly related to
computer age.

WCPUid is a program capable of providing you with
information about your processor, including its
speed and brand. This program is available at the
author’s web site:
http://hp.vector.co.jp/authors/VA002374/src/downlo
ad.html.
Alternatively, version 3.0d may be downloaded from
infopackets.com if the previous link does not work:
http://www.infopackets.com/dloads/wcpu30d.exe.
Download and install WCPUid, and look at the
Internal Clock value to determine your processor’s
speed. Look at the Name String to determine the
brand of your processor. Use the chart below to
determine if an upgrade is feasible with respect to
processing speed.

Processor Type

Processing Speed

Feasible? / RAM type

486
586 / Intel Pentium I
686/ Intel Pentium II
Intel Celeron / Celeron II
Intel Pentium III
AMD Athlon, Athlon XP

16 ~ 100 MHz
133 ~ 233 MHz
266 ~ 466 MHz
300+ MHz
500 ~ 1000 MHz
600+ MHz

Intel Pentium IV

1000+ MHz +

no
no
yes, some PC66 & PC100
yes, some PC66 & PC100
yes, PC100 or PC133
PC100, PC133, DDR **
yes, some PC133, but
RDR is an upcoming
standard **

** RDR RAM is more expensive compared to PC100 or PC133 RAM because it is
an upcoming standard. RDR RAM was recently introduced with Pentium 4's; it is
roughly 4 times as expensive compared to PC133 RAM. Newer generation of
AMD's Athlon, including the Athlon XP processor use DDR RAM which is roughly 2
times more expensive than PC133 RAM and runs at a bus rate of 266 MHz.

DID YOU FIND THIS GUIDE USEFUL?
Of course you did!

For more cool video tutorials and eBooks by Dennis Faas, you might want to check out
these pages online our site:

How to Install / Reinstall Windows – The Video and Ebook Ultimate Guide: Whether
you’re installing Windows for the first time, or, if you’re reinstalling Windows because your system no longer
functions properly – this video and eBook guide will teach you how to backup your files and get Windows
back up and running in Tip Top shape!
How to Install a Hard Drive – The Video: If you’re looking to add more storage to your computer,
then what you really need is another hard drive. How to Install a Hard Drive: The Video is an essential
guide that explains all the “need to know” answers that most people were afraid to ask – in SIMPLE English!
Best of all, it’s a GREAT companion for the ‘How to Install / Reinstall Windows Video and eBook Ultimate
Guide’!

The Windows Primer: The Windows Primer is an amazing eBook crammed full of helpful tips and ideas
to make learning Windows as easy as 1-2-3. Made especially for new and intermediate computer users, the
Windows Primer teaches Windows from Start to Finish!

Keyboard Secrets – The Video: Did you know that learning to use your keyboard effectively can
dramatically cut down on the time that it takes to complete a task? It’s true! With Keyboard Secrets, you’ll
learn to increase productivity time with ANY program using your keyboard. Stop reaching for your mouse
when you don’t need to!

GLOSSARY
16 Bit Color
Add/Remove Programs
Advanced Move
Auto Arrange
Backdrop Image
Blue Screen of Death
BSOD
Buffer
C Drive
Cache
Click
Clipboard
Color Depth
Critical Update Packages
CTRL Key
Cut and Paste Technique
Cut
Database
Defrag
Defragging
Desktop
Dialogue Menu
Disk Defragmenter
Display Properties
Download Folder
Dynamic Link Libraries
Email Harvester
Energy Saving Mode
Favorites
FindFast.Exe
Firewall
Folder
Folders View
Ghosted
Ghosted Window Objects
Hackers
Header
Home Page
Horizontal Scroll Bar
Icon Spacing
Icon
ICQ
Inbox
Internal Clock
Internet Connection Wizard
Internet Explorer
Internet Service Provider
ISP
Left-Click
Lock Up
Mail Headers

Maximize
Message Rules
Minimize
Movable Object
Multitasking
My Computer
New Mail Button
News Group Etiquette
News Server
Object Type
Object
Outlook Express
Paste
Programs Folder
Pull-down Box
RAM
Read/Write Heads
Reboot
Recycle Bin
Resolution
Right-Click
Screen Saver
Scroll Bar
Send and Receive Button
Shortcut
Single Click
Slider Bar
Software Firewall
Spam
Square-like Selection
Start Menu
Startup Folder
Super VGA
SVGA
System Registry
Temporary Internet Files
Thread Button
Thread
Unexpected Results
Vertical Scroll Bar
VGA
VGA-Only
Video Memory
Windows Registry
WCPUid

COPYRIGHT © 2001 Computer 411, All Rights Reserved.
No part of this publication may be duplicated in any form without the authorized
consent of the publisher.
All Registered Trademarks are respective of their owners.

